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Installing Additional Content Packs
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for
5.0.35.2 Additional Content Pack(s)

Step 1: Run Content Installer for Additional Content
Pack(s)

1. The Welcome dialog will open. Click Next.

i'.‘% BizInsight Content Installer Content Packia) Setup =] 3

' Welcome to the Bizlnsight Content

Installer  Content Pack Name Setup
Wizard

The Setup Wizard will install BizInsight Content Installer
BizInsightSunGardEAS on wour computer, Click Mext bo
continue or Cancel ko exit the Setup Wizard.

Back Cancel |

2. Review the End User License Agreement and if you agree to the terms, check the |
accept the terms in the License Agreement checkbox and click Next.

& -

= =10l =]
End-User License Agreement

Flease read the following license agreement carefully

#9BizNetsoftware’

4

End User License Agreement

INOTICE TO ALL USERS: PLEASE READ THIS AGREEMENT
CAREFULLY. BY CLICKING THE ‘T AGREE™ BUTTON AT
THE BOTTOM OF THIS PAGE OR BY INSTALLING AND
USING THE SOFTWARE. YOU AGEEE TO ACCEPT ALL OF
THE TERMS AND CONDITIONS OF THIS AGREEMENT
AND YOU AGREE THAT THIS AGREEMENT IS

TATCAOADCTADIT AC TC TT ITATY DOTAT CT/AALTTY DV WATT 'I'ELI

¥ I accept the terms in the License Agreement

Print Badk I Mext I Cancel I
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for

5.0.35.2

Additional Content Pack(s)

3. Click on the desired Setup Type button.

i‘é’- BizInsight Content Installer SaSssias Setup ) =10lxl

Choose Setup Type

Choose the setup type that best suits your needs
#29BizNetsoftware’

Installs the most common program features. Recommended for most users.

Custom |

Allows users to choose which program features will be installed and where
they will be installed. Recommended for advanced users.

Complete |

All program features will be installed. Requires the most disk space.

Badk | et | Cancel

Custom setup type options that are available:

i‘é’- BizInsight Content Installer SaSs S Setup ) - =]

Custom Setup

Select the way you want features to be installed.
#7¢BizNetsoftware’

Click the icons in the tree below to change the way features will be installed.

= L4 | BizInzight
<=3 = | Desktop Shortcut
- (=3 | Program Menu Shortout

This feature requires 327ME on
your hard drive.

4 | |

Location: C:\Program Files (x86)\BizNet Software\BizNetERP B
1.0.0.0Y

Reset Disk Usage Back I Mext I Cancel |
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for
5.0.35.2 Additional Content Pack(s)

4. Click Install.
IE(

Ready to install BizInsight Content Installer o
#2¢BizNetsoftware’

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I @ Install I Cancel

5. Click Yes to any User Account Control messages.

@ User Account Control [ |

F Do you want to allow the following program from an unknown
./ publisher to make changes to this computer?

Program name: - - -

Publisher: Unknown
File origin: Hard drive on this computer

j Show details Yes | No I

Change when these notifications appear

6. When the installer completes, an icon will exist on the desktop if you did not dis-
able the creation of shortcuts.

e

BizInsight

- g W aa

7. Double-click the shortcut on the desktop to launch the content installer. If you
chose a Custom installation and disabled the creation of shortcuts, you must
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for
5.0.35.2 Additional Content Pack(s)

browse to the directory to which the content installer files were extracted and
double-click the BizNet Content Installer.exe. If you installed to the default dir-
ectory location, that directory can be found in C:\Program Files (x86)\BizNet Soft-
ware.

8. The content installer will inspect the server and determine what elements already
exist and indicate their presence with a green check mark.

BizInsight Content Installer x|

Relevant Information

:
" Reporting Server Found

—M | Install St
e ——— “ Reporting Server User Found

MI Q Scripts Have Not Been Run
MI Q S 8 DataSet Content Not Found
Run Script Files | g S 8 MetaData Content Not Found

9 S % Function Content Not Found
& Users Have Been Added by Admin Tool

Eelavibta e bR =) ¥ Setiings Need To Be Configured by Config Tool
Deploy MetaData Content |
Deploy Function Content |

Admin Tool |
Config Tool |

e o

Sage 100 ProvideX customers will see the following:

BizInsight b mas Content Installer x|

Relevant Information

| Automatic Install I

"' Reporting Server Found

r—Manual Install St
anual insist Siages "¢ Reporting Server User Found

' Link Servers Found

Create Report Server User | s DataSet Content Not Found

Q st MetaData Content Not Found

Q S8 Function Content Not Found

" Users Have Been Added by Admin Tool

' Settings Need To Be Configured by Config Tool

Install Report Server |

Link Servers

Deploy DataSet Content

Deploy MetaData Content

Deploy Function Content

Admin Tool

Corfig Tool

View Addttional Files

Exit
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for
5.0.35.2 Additional Content Pack(s)

9. Click on the Relevant Information link in the upper right corner and make a note
of the Report Folder name:

nsigh b - .
Relevant Information
PEE] cleventinormacon -Ioix]
[ Manual install Stages  Config Path: \\SERVER2D08RCorfiqurationPath
Install Report S CABizlnsight Share*Cortfig
Creste Report Sen  agmin Path \\SERVER2008R2\Administration Paih
Run Script Fil CABizlnsight Share\Admin
Report Server Ur: http.//SERVER2008R2/Report Server
Deploy DataSet € Report Folder BizNe{ERP
Deploy MetaData !
Sql Server MetaData
Deploy Function C Database and Instance Name: SERVERZ008RZ
Admin Tool Packaged with Content Packager Version 1.4.0.0
Conrfig Tt
__omg oo Copy to Clipboard |
Ba | )

Note |If the Relevant Information dialog does not contain any information and
Bizlnsight is already installed, go to a workstation where BizInsight is installed.
Open Excel on the workstation, click on the Application Settings button on the
BizInsight ribbon and copy the values provided for the Configuration Path, the
Administration Path, the Default Reporting Services Server and the Default
Reporting Services Folder Name fields.

10. Click Automatic Install.

BizInsight © o waw Content Installer x|

' Automatic Install '

\ ' | Reporting Server Found
[ tetet Fagee ' Reporting Server User Found
MI 9 Scripts Have Not Been Run

Create Report Server User Q S8 DataSet Content Not Found

Run Seript Fles 0 S MetaData Content Not Found

0 S8 Function Content Not Found
"' Users Have Been Added by Admin Tool

MI ' Settings Need To Be Configured by Config Tool
Deploy MetaData Contert
Deploy Function Content

Admin Tool
Config Tool

e o

Relevant Information
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for
5.0.35.2 Additional Content Pack(s)

11. The content installer will deploy the MetaData and function content. The path
will be automatically defaulted to the path last used. Click OK.

Pre Installation Question

Please choose a directory location forthe Corfiguraion Path:  [= Bizinsih 51 Corfin

Deploy Local Cortent
’7 This directory will become a shared network directory after the installation process.

™ Ovenide Corfiguration Path

Ok Cancel

12. The content installer will open the content deployment dialog. Most paths will
not need to be changed. But you must check the following to make sure they are
correct:

a. Make sure the folder name is the folder name currently being used. If the
folder is not the same as shown in the Relevant Information dialog,
change that field to match the folder that is currently being used.

=
I ol
IC: \Program Files {<86)\BizMet Softw Corfig Peth: e
Directory whers you instalisd the content{ C:\Bizlnsight Share\Corfig
Change the folder name if \\SERVER2D08R2\AdministrationPath
—Reporting Services Settings — it does nat match the C:\Bizlnsight Share’ Admin

information from the
a Services Se Relevant Information http-//SERVER2008R2/Report Server

3 /Rend dialog
o BizNetERP
Server MetaData

rEm——
q
Database and Instance Name: SERVERZ2008R2

Copy to Clipboard
Deploymert Options .
’7 | Data Source Name: |

b. Sage 100 ProvideX customers, skip this step.
Adjust the Server Name field if your accounting system database is on
another server. NOTE |The server name will default to the last server used.
This may not be the right server for the content pack being deployed.

Full name of the foider on the reporting sei

c. Sage 100 ProvideX customers, skip this step.
Adjust the Database Name field to point to your accounting system data-
base. If your accounting software uses a system or control database,
provide the name of that database rather than a company database name.
NOTE|The database name will default to the last database used. This may
not be the right database for the content pack being deployed.
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for
5.0.35.2 Additional Content Pack(s)

13.

14.
15.

16.

Sage 100 ProvideX customers, skip this step - you must use Windows authen-
tication.

Select the desired authentication method - Windows authentication or Prompt
for Credentials.

| IMPORTANT |You must use the same authentication method as selected for
other content packs.

— Deployment Options ——— [ Datasource Configuration
Data Source Name:
™ Ovenwrite Datasounces I'.'EE:'
Server Name:
V' Overwrite Reports |SEHVEH2[§-D3
I= | Preserve Folder Structure Lo
ID},'namics

™ Use Folders for Datasources f'& Uze Windows Authentication
( ™ Prompt For Credentials

=

Deploy Contert | Exit |
A

Click Deploy Content.

The content installer will display a status message to indicate that it is working.

Working, Please Be Patient

4

Once complete, the installer will display links to the Reporting Services sites.
Click OK to continue with the installation.
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for
5.0.35.2 Additional Content Pack(s)

17. The License Administration Tool will open. Unless you need to add new users,
click Exit.

License Administration Tool - SERVER2008R2\linda =10 x|

Administration Path

| ]

MNetwark share where your license file is stored.

Validate License |

.g F
o

18. The content installer window will display the results of the automatic install.
Click Close.
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for

5.0.35.2

Additional Content Pack(s)

19. Click Exit to close the content installer.

X

BizInsight v Content Installer
Relevant Information
| Automatic Install I

— Manual Install Stages
Install Report Server |

Create Report Server User |

Run Script Fies |

Deploy DataSet Cortert |

Deploy MetaData Contert |

Deploy Function Content |

Admin Tool |

Corfig Tool |

(= |

—

' Reporting Server Found

" Reporting Server User Found

' Scripts Have Been Run

S DataSet Content Found

S . MetaData Content Found

&/ 8 Function Content Found

" Users Have Been Added by Admin Tool

¥ Settings Have Been Configured by Config Tool

n

20. Repeat the above steps for each content pack that needs to be installed.
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Installing Additional Content Packs: Step 2: Updating Client

Bizlnsight 5.0.35.2 Workstations

Step 2: Updating Client Workstations

Once all BizContent updates have been updated on the server, each client workstation
installation needs to be updated with the new content add-in files and BizInsight
Desktop Edition installed if the new content pack is a System Connector.

If BizInsight is being used in a Citrix/Terminal Services environment, see "Implementing
Additional BizInsight Content on a Citrix/Terminal Services Server" on page 14.

If BizInsight is installed on individual workstations, instruct all BizInsight users to click
on the Scan for Content button on the Bizinsight ribbon in Excel to update their work-
stations with the new content.

T B B X B Q B M

Bizlnsight Application  Data  Expression Offline Save Changes Scanfor Bizhet About
Explorer  Settings  Caches  Editor to Bizlhsight Conte%t.ﬂ.ssistant

BizInsight Reparting and Analytics

If the users report that the Scan for Content button is missing, they may not have the
most current BizInsight version. The Scan for Content button was added in version .

BizNet Software recommends downloading and installing the latest BizInsight version
but if you must use an older version, see "Manually Installing BizContent Add-ins" on

page 15.

If your users report an error similar to the following when opening Excel again, see
"Resolving “.xll could not be found” errors" on page 27 for steps to resolve.

Install Bizlnsight Desktop Edition

If you are implementing a System Connector release, the BizInsight Desktop Edition
product must installed on the client workstation, if it is not already present.

1. Download the BizInsight Desktop Edition product from the customer portal site,
http://biznet.flexnetoperations.com.

2. Extract the contents and double-click the setup.exe

BizNet Software, Inc 10| Page
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Bizlnsight 5.0.35.2

Installing Additional Content Packs: Step 2: Updating Client

Workstations

3. The installer will prompt to download the BizNet API. Click Install.

4.

:_J Bizlnsight - Desktop Edition Setup -I

The following compaonents will be installed on yaur machine:

BizNet API 1.0.3

Do you wish to install these components?

If yau chooge Cancel, setup will exit.

‘ Irigkall | | Cancel

& IMPORTANT

If the .msi is run before running the setup.exe, the following error will occur:

i F 1 The BizMetfPl is required for this program. Install BizMetaPl and then
" retry

If a User Account Control dialog opens, click Yes.

BizNet Software, Inc
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Bizlnsight 5.0.35.2

Installing Additional Content Packs: Step 2: Updating Client

Workstations

5. The End User License Agreement dialog will open. Review the license terms and if
you agree with the terms, select the | agree radio button and click Install.

P

Back. | Install | | Cancel

jk‘_j! Bizlnsight - Desktop Edition Setup -— =] -

Please read the BizInsight - Desktop Edition
License Agreement

End User License
Agreement
(Subscription Based)

NOTICE TO ALL USERS: PLEASE EEAD
THI: AGEEEMEIT CAREFULLY. BY
CLICEING THE “T AGEEE” EUTTON AT
THE ECTTOM OF THLS PAGE OE BY
IETATLLING AND TISING THE

b

[#]1 accept the terms in the License Agresment

6. Click Finish when the installation completes.

P

jk‘_j! Bizlnsight - Desktop Edition Setup -— m] -

Completed the Bizlnsight - Deskiop
Edition Setup Wizard

Click the Finish butkan b exit the Setup Wizard.

Back. Cancel

BizNet Software, Inc
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

Appendices
Implementing Additional Bizinsight Content on a Citrix/Terminal
SEIVICES S@IVEI ... 14
Manually Installing BizContent Add-ins ... 15
Resolving “.xll could not be found” errors ... 27
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

Implementing Additional Bizinsight Content on a Citrix/Terminal Ser-
vices Server

1. Copy all new BizContent add-in files (.dll, .dna and .xll) from the Configuration
Path to the local BizInsight directory. If you do not know the location of the Con-
figuration Path, launch the Content Installer on the server and click on the Rel-
evant Information link in the upper right of the dialog.

2. Browse to the reg5 subdirectory of the local BizInsight directory. Open the file
named "Excelxxxx_register_OnDemand.reg" with Notepad.

3. Copy the last Openn entry in this file and paste directly below. Increment the
Openn and change the name to the new BizContent .xll file name. Repeat for each
new content .xll file until all are represented in the file. For example:

"OPEN"="/A \"BizInsightXL.Foundation\""

4. Save your changes to the file.

5. Browse to the reg5 subdirectory of the Bizlnsight directory and execute the
"Register BizInsight for Excel xxxx OnDemand.bat" file to make sure it runs
without error.

6. Have each BizInsight user execute the "Register BizInsight for Excel xxxx OnDe-
mand.bat" to register the additional content for their login.

BizNet Software, Inc 14| Page



Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

Manually Installing BizContent Add-ins

If you are using a Bizlnsight version that is older than , you will need to register the
BizContent add-ins manually in Excel. BizNet Software recommends upgrading to the
latest BizInsight version but if that is not possible, perform the following steps:

1. Browse to the Bizinsight shared directory and copy the content add-in files (.dll,
xll and .dna) to the directory to which you installed the BizInsight client. If you
are using separate config and admin folders, the client add-in files will be in the
config folder.

BizInsight — O] %
[ ]
‘G( :}v| .+ O5(C:) = BizInsight ~ - l‘i]] I Search BizInsight \Ei]‘
Organize *  Includein library =  Sharewith + 3> HE - B:l I@l
. bing
regs

&BizNetERF‘.dll

| 7| BizhetERP. dna

[ BizMetERP, =l

[} ©pen a Suppart [ssue

o items

The remaining steps vary based on the Office version installed:

Office 2010/2013 steps
Excel 2007 steps
Excel 2003 steps

Excel 2010/2013

1. Click on File > Options.
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BizInsight 5.0.35.2 Installing Additional Content Packs: Appendices

E- ri ) - - |
.i. Home Insert
= save

B save As

£ Open

jj Close
Info

Mew

Print

Save & Send

Help

| :] Options L; |
B Exit
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BizInsight 5.0.35.2

Installing Additional Content Packs: Appendices

Click on Add-ins in the left pane and then click on Go at the bottom on the

right pane.

Headers and Footers
Hidden Rows and Columns
Hidden Worksheets
Invisible Content
Microsoft Actions Pane 3
Solver Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

S\Microsoft Office’\Officel 4.OFFRHD.DLL
E]\Micrasoft Office\Office14\OFFRHD.DLL
AT\Microsoft Office\OMiceld\OFFRHD.OLL
A&f'\Microsoft Office\Officel $\OFFRHD.DLL

e\ Officel 4 Libran\SOLVER\SOLVER.XLAM

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deseription:  AddinModule

Document Inspector
Document Inspector
Document Inspector
Document Inspector
XML Expansion Pack
Excel Add-in

21
General "
4 s View and manage Microsoft Office Add-ins.
Formulas
Pracfing Aga-ins
Save Mame - [Locatian [Type [4]
Active Application Add-ins
Language Bizinsight CABizlnsight\binS\aculoader. dll COM Add-in
p— SizinsightXL Faundation CAWindowes\SysWOWE4\mscoree.dil Excel Add.in
o R Inactive Application Add
Analysis ToolPak JieeOMiceld\LibraryAnalysis ANALYSI2.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA (Officeld\Libranp\Analysis\ATPVBAEN.ILAM  Excel Add-in
Custom XML Data &l'\Microsoft Office\Officel 00OFFRHD.OLL  Document Inspector
Add-Ins Date (MU Jes\microsoft shared\Smort Tag\MOFLDLL  Action
Eura Currengy Toals A Office\Dfice1 #\Library EUROTOOLNLAM  Excel Add-in
Trust Center Finandial Symbal (ML) Jes\microsoft shared\Smart Tag\MOFLDLL  Action

Manage: [Excel Ad

BizNet Software, Inc
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

2. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizlnsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in

Il

Automation...

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.
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BizInsight 5.0.35.2 Installing Additional Content Packs: Appendices

Excel 2007

1. Click on the Office button and then click on the Excel Options button.

]

Recent Documents

Hew
1 BizProperySheetdlsx W=l
% Open 4 Balance Sheet.xit
3 Balance Sheet.xls =l
4 SetGlobalProperties.xlsx =

zave

Save As ¥

Print k

Prepare #

& KPP AT

L
o
= |

[=3
-

Pyblish »

- g

Close

1) Excel Options [ X Exit Excel
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BizInsight 5.0.35.2

Installing Additional Content Packs: Appendices

Click on Add-ins in the left pane and then click on Go at the bottom on the

right pane.

Headers and Footers
Hidden Rows and Columns
Hidden Worksheets
Invisible Content
Microsoft Actions Pane 3
Solver Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

S\Microsoft Office’\Officel 4.OFFRHD.DLL
E]\Micrasoft Office\Office14\OFFRHD.DLL
AT\Microsoft Office\OMiceld\OFFRHD.OLL
A&f'\Microsoft Office\Officel $\OFFRHD.DLL

e\ Officel 4 Libran\SOLVER\SOLVER.XLAM

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deseription:  AddinModule

Document Inspector
Document Inspector
Document Inspector
Document Inspector
XML Expansion Pack
Excel Add-in

21
General "
4 s View and manage Microsoft Office Add-ins.
Formulas
Pracfing Aga-ins
Save Mame - [Locatian [Type [4]
Active Application Add-ins
Language Bizinsight CABizlnsight\binS\aculoader. dll COM Add-in
p— SizinsightXL Faundation CAWindowes\SysWOWE4\mscoree.dil Excel Add.in
o R Inactive Application Add
Analysis ToolPak JieeOMiceld\LibraryAnalysis ANALYSI2.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA (Officeld\Libranp\Analysis\ATPVBAEN.ILAM  Excel Add-in
Custom XML Data &l'\Microsoft Office\Officel 00OFFRHD.OLL  Document Inspector
Add-Ins Date (MU Jes\microsoft shared\Smort Tag\MOFLDLL  Action
Eura Currengy Toals A Office\Dfice1 #\Library EUROTOOLNLAM  Excel Add-in
Trust Center Finandial Symbal (ML) Jes\microsoft shared\Smart Tag\MOFLDLL  Action

Manage: [Excel Ad
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

3. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

4. Browse to the directory to which you installed Bizinsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in

Il

Automation...

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

5. Click OK.
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BizInsight 5.0.35.2 Installing Additional Content Packs: Appendices

Excel 2003

1. Click on Tools > Add-Ins

B3 Microsoft Excel - Book2

23] File Edt View Insert Format | Tools | Data Window Hel
TRWER- NPV IR AV Rl ™’
B1 - 5~ a Research.,. Ak+Click
» | A =] c ‘j) Errar Checking,.. G
—{ |
o 5 I Speech k
-!- 3 | Shared Warkspace. ..
-E % Share Workbock. .
; | | Track Chaniges »
2 omipare and Merge Waorkbooks. .,
s a1
g T Protection k
10 Cpline Collsboration 3
| 11| Goal Seek...
E— Scenarios. ..
13
14 Formula Auditing ¥
15| l Macra 3
16
17 ety [
18| 3 AutoCorrect Options.. .
%‘ ngsFoniae...
M Qptions. ..
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

2. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizlnsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in

Il

Automation...

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.
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Resolving “.xll could not be found” errors

In some rare instances, the name of the content add-in file provided with an update may
change. When an add-in file name is changed, Scan for Content will properly remove
that add-in file but will not delete the pointer to it that resides within Excel and the fol-
lowing error will occur:

Microsoft Office Excel @

‘cilusersYinda‘documents\BizContent'\BizMetERP. xl' could not be found. Check the spelling of the file name, and
verify that the file location is correct.

If you are trying to open the file from your list of most recently used files, make sure that the file has not been

renamed, moved, or deleted.

Perform the following steps to resolve the issue:

The remaining steps vary based on the Office version installed:

Office 2010/2013 steps
Excel 2007 steps
Excel 2003 steps

Excel 2010/2013

1. Click on File > Options.
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E- ri ) - - |
.i. Home Insert
= save

B save As

£ Open

jj Close
Info

Mew

Print

Save & Send

Help

| :] Options L; |
B Exit
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BizInsight 5.0.35.2

Installing Additional Content Packs: Appendices

Click on Add-ins in the left pane and then click on Go at the bottom on the

right pane.

Headers and Footers
Hidden Rows and Columns
Hidden Worksheets
Invisible Content
Microsoft Actions Pane 3
Solver Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

S\Microsoft Office’\Officel 4.OFFRHD.DLL
E]\Micrasoft Office\Office14\OFFRHD.DLL
AT\Microsoft Office\OMiceld\OFFRHD.OLL
A&f'\Microsoft Office\Officel $\OFFRHD.DLL

e\ Officel 4 Libran\SOLVER\SOLVER.XLAM

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deseription:  AddinModule

Document Inspector
Document Inspector
Document Inspector
Document Inspector
XML Expansion Pack
Excel Add-in

21
General "
4 s View and manage Microsoft Office Add-ins.
Formulas
Pracfing Aga-ins
Save Mame - [Locatian [Type [4]
Active Application Add-ins
Language Bizinsight CABizlnsight\binS\aculoader. dll COM Add-in
p— SizinsightXL Faundation CAWindowes\SysWOWE4\mscoree.dil Excel Add.in
o R Inactive Application Add
Analysis ToolPak JieeOMiceld\LibraryAnalysis ANALYSI2.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA (Officeld\Libranp\Analysis\ATPVBAEN.ILAM  Excel Add-in
Custom XML Data &l'\Microsoft Office\Officel 00OFFRHD.OLL  Document Inspector
Add-Ins Date (MU Jes\microsoft shared\Smort Tag\MOFLDLL  Action
Eura Currengy Toals A Office\Dfice1 #\Library EUROTOOLNLAM  Excel Add-in
Trust Center Finandial Symbal (ML) Jes\microsoft shared\Smart Tag\MOFLDLL  Action

Manage: [Excel Ad
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2. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizlnsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in

Il

Automation...

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.
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Excel 2007

1. Click on the Office button and then click on the Excel Options button.

]

Recent Documents

Hew
1 BizProperySheetdlsx W=l
% Open 4 Balance Sheet.xit
3 Balance Sheet.xls =l
4 SetGlobalProperties.xlsx =

zave

Save As ¥

Print k

Prepare #

& KPP AT

L
o
= |

[=3
-

Pyblish »

- g

Close

1) Excel Options [ X Exit Excel
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BizInsight 5.0.35.2

Installing Additional Content Packs: Appendices

Click on Add-ins in the left pane and then click on Go at the bottom on the

right pane.

Headers and Footers
Hidden Rows and Columns
Hidden Worksheets
Invisible Content
Microsoft Actions Pane 3
Solver Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

S\Microsoft Office’\Officel 4.OFFRHD.DLL
E]\Micrasoft Office\Office14\OFFRHD.DLL
AT\Microsoft Office\OMiceld\OFFRHD.OLL
A&f'\Microsoft Office\Officel $\OFFRHD.DLL

e\ Officel 4 Libran\SOLVER\SOLVER.XLAM

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deseription:  AddinModule

Document Inspector
Document Inspector
Document Inspector
Document Inspector
XML Expansion Pack
Excel Add-in

21
General "
4 s View and manage Microsoft Office Add-ins.
Formulas
Pracfing Aga-ins
Save Mame - [Locatian [Type [4]
Active Application Add-ins
Language Bizinsight CABizlnsight\binS\aculoader. dll COM Add-in
p— SizinsightXL Faundation CAWindowes\SysWOWE4\mscoree.dil Excel Add.in
o R Inactive Application Add
Analysis ToolPak JieeOMiceld\LibraryAnalysis ANALYSI2.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA (Officeld\Libranp\Analysis\ATPVBAEN.ILAM  Excel Add-in
Custom XML Data &l'\Microsoft Office\Officel 00OFFRHD.OLL  Document Inspector
Add-Ins Date (MU Jes\microsoft shared\Smort Tag\MOFLDLL  Action
Eura Currengy Toals A Office\Dfice1 #\Library EUROTOOLNLAM  Excel Add-in
Trust Center Finandial Symbal (ML) Jes\microsoft shared\Smart Tag\MOFLDLL  Action

Manage: [Excel Ad
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3. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

4. Browse to the directory to which you installed Bizinsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |

BizNet Software, Inc 34| Page



Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in

Il

Automation...

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

5. Click OK.
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Excel 2003

1. Click on Tools > Add-Ins

B3 Microsoft Excel - Book2

23] File Edt View Insert Format | Tools | Data Window Hel
TRWER- NPV IR AV Rl ™’
B1 - 5~ a Research.,. Ak+Click
» | A =] c ‘j) Errar Checking,.. G
—{ |
o 5 I Speech k
-!- 3 | Shared Warkspace. ..
-E % Share Workbock. .
; | | Track Chaniges »
2 omipare and Merge Waorkbooks. .,
s a1
g T Protection k
10 Cpline Collsboration 3
| 11| Goal Seek...
E— Scenarios. ..
13
14 Formula Auditing ¥
15| l Macra 3
16
17 ety [
18| 3 AutoCorrect Options.. .
%‘ ngsFoniae...
M Qptions. ..
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2. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizlnsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add-1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in
Automation...

Il

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.

9. Once in the add-ins dialog, uncheck the add-in mentioned in the error message.
You should get the following message. Click Yes. If you do not get this message,
you have unchecked the wrong add-in. Re-check it and uncheck the next one

that is shown that has a similar name.
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(Add-Ins e=)

Add-Ins avalable:

|| Anatysis ToolPak - oK

|| Analysis ToolPak - VBA

|w'] BizinsightXL. Foundation
|| Condrional Sum Wizard

e
|| Internet Assistant VBA Bra

oI
W ]
|| Sohver add-n
Microsoft Office Excel [=3e]
'ﬂ Cannot find add-n "C:\BizMet Software \BizInsighi off. Dedete from list?
[ ves | [ Mo

10. Close and reopen Excel to confirm that the error no longer occurs.
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